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Exp. No 1 MS Excel - Introduction 

 

Question: 

Write a detailed note on Microsoft Excel and explain its features, menus, and functions.   

Aim: 

The aim of the experiment is to give a detailed note on MS Excel and its main features, menus, and functions.  

Procedure: 

Microsoft Excel, commonly known as Excel, is part of the Microsoft 365 suite of software. Microsoft Excel is a 

spreadsheet editor developed by Microsoft for Windows, macOS, Android, iOS and iPadOS. Microsoft Excel is a 

general-purpose electronic spreadsheet used to organize, calculate, and analyze data. 

To open MS Excel: 

1. To open Excel, click on the Windows icon in the windows task bar and search for Excel.  

 

2. It will open the Welcome screen. 

3. Now click on New and then click on Blank Workbook 
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The Workbook 

1. A workbook is an Excel file that contains one or more worksheets (referred to as spreadsheets). 

2. Excel will assign a file name to the workbook, such as Book1, Book2, Book3, and so on, depending on how many 

new workbooks are opened. 

 

 



BA 3141 – Spreadsheet Modelling Laboratory      Lab Manual Ver 1.0 
    

Department of Management Studies | Regulation 2023 Page | 3  

Key Features of Microsoft Excel: 

1. Spreadsheet Management: Excel allows users to create, open, and save spreadsheets, which are called workbooks. 

Each workbook consists of individual sheets where data can be entered and manipulated. 

2. Data Entry and Formatting: Users can enter data into cells and format it according to their preferences, such as 

font styles, colors, cell borders, and more. 

3. Formulas and Functions: Excel offers an extensive library of built-in functions and allows users to create custom 

formulas to perform calculations on data. Functions can range from simple arithmetic to complex statistical, 

financial, and logical operations. 

4. Data Analysis Tools: Excel provides various data analysis tools, such as sorting, filtering, pivot tables, and charts, 

enabling users to gain insights from large datasets easily. 

5. Conditional Formatting: This feature lets users apply formatting rules based on specific conditions, making it easy 

to highlight important data or patterns in the spreadsheet. 

6. Charts and Graphs: Excel supports a wide range of chart types, such as bar charts, line graphs, pie charts, and 

more. These visualizations help users understand data trends and patterns quickly. 

7. Data Validation: Users can set data validation rules to control what data can be entered into specific cells, ensuring 

data accuracy and consistency. 

8. What-If Analysis: Excel allows users to perform "what-if" analysis by using scenarios, goal seeking, and data tables 

to explore different possibilities based on varying inputs. 

9. Collaboration: Excel supports collaboration features that allow multiple users to work on the same workbook 

simultaneously and view changes in real-time. 

10. Data Import and Export: Users can import data from various sources, such as other spreadsheets, databases, and 

external files. Excel also allows data export to other formats, such as CSV, PDF, and more. 

11. Macros and VBA: Advanced users can create and run macros using Visual Basic for Applications (VBA) to 

automate repetitive tasks and enhance Excel's functionality. 

12. Data Consolidation: Excel enables users to consolidate data from different sheets or workbooks into a single sheet 

for analysis or reporting. 

13. Data Protection: Excel offers security features like password protection and permission settings to control access 

to sensitive data. 

14. Add-ins and Extensions: Excel supports various add-ins and extensions that enhance its capabilities, such as data 

analysis tools, third-party integrations, and custom functions. 
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Menus in Excel 

1. Home Menu: Comprises options like font size, font styles, font colour, background colour, alignment, formatting 

options and styles, insertion and deletion of cells and editing options. 

2. Insert Menu: Comprises options like table format and style, inserting images and figures, adding graphs, charts 

and sparklines, header and footer option, equation, and symbols. 

3. Page Layout Menu: Themes, orientation and page setup options are available under the page layout option. 

4. Formulas Menu: Since tables with a large amount of data can be created in MS excel, under this feature, you can 

add formulas to your table and get quicker solutions.  

5. Data Menu: Adding external data (from the web), filtering options and data tools are available under this category. 

6. Review Menu: Proofreading can be done for an excel sheet (like spell check) in the review category and a reader 

can add comments in this part.  

7. View Menu: Different views in which we want the spreadsheet to be displayed can be edited here. Options to zoom 

in and out and pane arrangement are available under this category. 

Common Functions in MS Excel: 

There are a variety of functions. Here are some of the most common functions you'll use: 

1. SUM: This function adds all the values of the cells in the argument. 
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2. AVERAGE: This function determines the average of the values included in the argument. It calculates the sum of 

the cells and then divides that value by the number of cells in the argument. 

 

3. COUNT: This function counts the number of cells with numerical data in the argument. This function is useful for 

quickly counting items in a cell range. 

 

4. MAX: This function determines the highest cell value included in the argument. 
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5. MIN: This function determines the lowest cell value included in the argument. 

 

6. Max: This function gives the maximum value included in the argument. 
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Exp. No 2 MS Excel – Data Tables 

 

Question: 

Prepare a Data Table to process the result of the given students in their Final Exams. 

Sl. No. Reg. No. Student Name Tamil English Maths Science History Civics Lab 

1 1001 Aarthi. B 69 72 68 60 66 61 77 

2 1002 Aarthisusila. C 80 68 72 71 74 75 76 

3 1003 Aasrisha. A 67 72 82 82 71 75 69 

4 1004 Abdur Raheman. S 75 78 76 80 78 76 76 

5 1005 Abinaya. S.M 79 80 84 82 70 78 75 

6 1006 Aishwarya. K 67 76 74 80 65 72 73 

7 1007 Ajay Theophilus. E 77 82 78 83 67 78 70 

8 1008 Ajith Kumar. V 66 80 82 82 75 72 74 

9 1009 Ajith Sundar. A 78 82 79 83 76 78 83 

10 1010 Ajithkumar. M 72 74 74 77 68 77 70 

11 1011 Akash. N 77 76 75 82 78 88 72 

12 1012 Anusuya. G 69 80 74 79 76 81 77 

13 1013 Arumugam. S 75 79 72 80 65 78 79 

14 1014 Aruna. A 74 66 67 77 68 71 69 

15 1015 Asha. A 64 77 77 80 62 79 67 

16 1016 Ashila. B 63 82 72 80 68 80 69 

17 1017 Ashokkumar. G 74 81 79 87 60 80 74 

18 1018 Aswini. K 84 80 73 81 53 86 76 

19 1019 Avinaash. S.M 87 82 84 87 83 85 78 

20 1020 Azhagarasan. M 77 78 72 77 73 81 76 

21 1021 Barath Raj. P 81 59 80 78 72 75 79 

22 1022 Brindha.B 83 82 77 88 80 86 80 

23 1023 Chithra. K 62 78 64 82 77 70 76 

24 1024 Chrisbin. C. S 65 82 76 82 78 74 76 

25 1025 Devayane. R 87 84 81 84 76 71 78 
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Aim: 

The aim of the experiment is to prepare a Data Table to process the result for the above students.  

Procedure: 

1. Click on Excel from the start menu. 

2. Open a new Workbook. 

3. Type the given data in Sheet 1 of the workbook with the Column Headers as given in the data. 

4. In Cell K1 give the Column Header as “TOTAL” and compute the total marks of the First Student using the syntax 

=SUM (D1:J1) and then press ‘Enter’. This will give the Total Marks of Student 1 in all the subjects.  

 

5. Go back to Cell K1 and Press CTRL + V to copy the formula.  

6. Now select the cell K2 to K26 and press CTRL + ALT + V. This will open the ‘Paste Special’ popup menu.  

 

7. In the pop-up menu click on ‘Formulas’ and then Click on ‘Ok’. 

8. Now the formula will be applied to all the students and the total marks will be computed.  
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9. The next step is to find the Rank obtained by students. Go to the next cell ‘L1’ and give the header as ‘Rank’. 

10. In the Cell L2 type the formula = RANK (K2, $K$2: $K$26) and Press ‘Enter’. Now the Rank for the student will 

be assigned.  

11. Now Copy the Formula and using ‘Paste Special’ function paste the formula for all the remaining students and the 

Rank will be assigned to the students.  

12. Now select the Rank for all the students and click on ‘Data’ Tab in the Menu Bar and Click on ‘Sort’ function. 

13. In the ‘Sort Warning’ popup click ‘Expand the selection’ and click on ‘sort’ and the Rank of the students will be 

sorted from 1 to 25. 

 

Output: 

 

Result: 

Thus, the Data Table is prepared, and the Result is analysed for the students.  
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Exp. No 2. a MS Excel – Data Tables – Extended Experiment 

 

Question: 

Given the Sales Data (File Name: Exp2.a-TwoWheelerSales) of Two-Wheeler brands across the districts of 

Tamilnadu, analyse the Data and find out the below: 

a) District wise total sales of Two Wheelers 

b) Average Sales of each brand of Two-Wheeler. 

c) Identify the Top 5 and Bottom 5 Districts in Overall Sales Volume. 

d) Identify and highlight the Maximum Selling District for each brand.  

 

Output: 

Students should be able to perform the experiment based on the instructions and generate the Output. 
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Exp. No 3.  MS Excel – Charts and Graphs 

Question: 

Prepare Result Analysis for the below students and prepare Column Charts indicating the below. 

a) Subject Wise Pass Percentage 

b) Subject Wise Fail Percentage 

c) Comparison Chart of Marks of Student Aarthi with that of the Class Average for Each Subject. 

Sl. No. Reg. No. Student Name Tamil English Maths Science History Civics Lab 

1 1001 Aarthi. B 69 61 68 60 58 61 78 

2 1002 Aarthisusila. C ab 55 72 71 73 75 63 

3 1003 Aasrisha. A 67 51 82 82 75 75 65 

4 1004 Abdur Raheman. S 55 62 35 56 70 30 35 

5 1005 Abinaya. S.M 79 60 84 82 71 78 58 

6 1006 Aishwarya. K 67 67 74 80 24 72 73 

7 1007 Ajay Theophilus. E 77 50 78 83 61 78 65 

8 1008 Ajith Kumar. V 66 61 82 82 74 72 59 

9 1009 Ajith Sundar. A 78 70 79 ab 79 78 68 

10 1010 Ajithkumar. M 72 50 74 77 71 77 61 

11 1011 Akash. N 27 70 75 ab 77 58 72 

12 1012 Anusuya. G 69 60 74 79 69 81 57 

13 1013 Arumugam. S 75 52 72 80 66 78 52 

14 1014 Aruna. A 74 50 67 77 42 71 54 

15 1015 Asha. A 64 43 77 77 76 79 58 

16 1016 Ashila. B 63 56 72 65 75 ab 55 

17 1017 Ashokkumar. G 74 52 79 87 75 80 66 

18 1018 Aswini. K 84 59 73 56 65 86 66 

19 1019 Avinaash. S.M 87 70 84 87 78 85 68 

20 1020 Azhagarasan. M 77 62 72 77 74 28 ab 

21 1021 Barath Raj. P 34 60 80 78 69 75 ab 

22 1022 Brindha.B 83 59 77 66 79 86 59 

23 1023 Chithra. K 62 55 64 82 69 70 65 

24 1024 Chrisbin. C. S 65 52 76 71 61 74 70 

25 1025 Devayane. R 87 65 81 84 74 71 65 
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Aim: 

The aim of the experiment is to prepare a subject wise result analysis and prepare column charts indicating the Subject 

Wise Pass Percentage, Fail Percentage and Comparison Chart of Student Aarthi Marks with the Class Average.  

Procedure: 

To Perform Result Analysis: 

1. Click on Excel from the start menu. 

2. Open a new Workbook. 

3. Type the given data in Sheet 1 of the workbook with the Column Headers as given in the data. 

4. Go to Cell D27 and compute the ‘Total Strength’ using the formula ‘=25-COUNTBLANK(D$2:D$26)’ and press 

‘Enter’ to compute the Total Strength for Tamil. Copy and Paste the Formula and compute the same for all the 

subjects.  

5. Go To Cell D28 and calculate the Number of Absent using the formula ‘=COUNTIF(D$2:D$26, “AB”)’ and press 

‘Enter’ to compute the number of absentees for Tamil. Copy and Paste the formula and compute the same for all 

the other subjects.  

6. Go to Cell D29 and calculate the Number of Present using the formula ‘=D27-D28’. Copy the formula and compute 

the same for all the other subjects.  

7. Go to Cell D30 and calculate the Number of Pass using the formula ‘=COUNTIF(D2:D26,">49")’ and press 

‘Enter’ to compute the number of passes in Tamil. Copy and Paste the formula and compute the same for all the 

other subjects.   

8. Go to Cell D31 and calculate the Number of Fail using the formula ‘=COUNTIF(D2:D26,"<=49")’ and press 

‘Enter’ to compute the number of failures in Tamil. Copy and Paste the formula and compute the same for all the 

other subjects.   

9. Go to Cell D32 and calculate the Pass Percentage using the formula ‘=D30/D29’ and press ‘Enter’ to get the values 

and change it to Percentage Format with One Decimal Value. Copy and Paste the formula and compute the same 

for all the other subjects.  (Pass Percentage = Total Pass / Total Present) 

10. Go to Cell D33 and calculate the Failures Percentage using the formula ‘=D31/D29’ and press ‘Enter’ to get the 

values and change it to Percentage Format with One Decimal Value. Copy and Paste the formula and compute the 

same for all the other subjects. (Fail Percentage = Total Fail / Total Present). 

11. Go to Cell D34 and calculate the Subject Average using the formula ‘=AVERAGE(D2:D26)’ and press ‘Enter’ to 

compute the subject average. Copy and Paste the formula and compute the same for all the other subjects.  

 

To prepare Column Charts for Pass Percentage and Fail Percentage: 

1. Select the Subject Header (D1:J1) and press CTRL and select Pass Percentage (D32:J32). 

2. Click on Insert Menu and Go to Charts Segment 
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3. Click on Bar Charts and select 2-D Column Chart and select Clustered Column Chart 

4. Customise the chart using the ‘Chart Elements’ and customise the name of the chart, data labels etc. 

5. Follow a similar procedure and prepare the Column Chart for Failure Percentage. 

To prepare Comparison Column Charts for Student Aarthi and Class Average: 

1. Go to Cell C2 and select C2:J2 and press CTRL and Select Subject Average C34:J34 

2. Click on Insert Tab in the Menu and Go to Charts Segment 

3. Click on Bar Charts and select 2-D Column Chart and select Clustered Column Chart 

4. Click on the Chart and the ‘Chart Design’ Menu will be displayed in the Menu Bar. Click on the ‘Chart Design’ 

Menu and click on ‘Change Chart Type.’ 

 

5. In the ‘Change Chart Type’ popup menu click on ‘Combo’ in the left side panel.  

6. Click on the ‘Check Box’ for Secondary Axis for the Series ‘Subject Average’ and then Click on ‘Ok.’ 

 

7. The Comparison Column Bar Chart will be displayed.  
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Output: 
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Result: 

Thus, the Result Analysis and Column Charts are prepared for the given data using the above procedure.   
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Exp. No 3. a MS Excel – Charts and Graphs – Extended Experiment 

 

Question: 

Given the Sales Data (File Name: Exp3.a-Super Market Sales Data) of a Super Market Chain you are required to 

perform the below: 

a) Overall COGS for Customer Type and Gender Type 

b) Prepare Colum Chart across Product Lines with the Mode of Payment. Use Grand Total as the Secondary axis. 

Output: 

Product Lines 
Mode of Payment 

Grand Total 
Cash Credit card Ewallet 

Electronic accessories 3968.09 7269.13 6207.65 17444.87 

Fashion accessories 4083.34 4995.58 6475.85 15554.77 

Food and beverages 4959.12 5909.27 5477.42 16345.81 

Health and beauty 3882.67 3205.22 4909.97 11997.86 

Home and lifestyle 9325.61 4583.23 7440.87 21349.71 

Sports and travel 5953.79 5556.38 6940.02 18450.19 
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Exp. No 4 MS Excel – Cell Referencing 

 

Question: 

Use Cell Referencing in excel and perform the following functions: 

a) Relative Referencing : Compute Net Income using Absolute Reference function. 

Month Total Sales Total Expenses 

January 20000 12000 

February 24500 18670 

March 35000 22564 

April 37560 28620 

May 43450 29569 

June 52000 30780 

July 56860 38020 

 

b) Absolute Referencing : Compute the Percentage using Absolute Reference function. 

Name of the Student Grade Total 

Max. Mark 100 

Aarthi 69 

Aarthisusila 80 

Aarshisha 67 

Abdur Rehman 75 

Abinaya 79 

Aishwarya 67 

Ajay 77 

Ajith Kumar 66 

Ajith Sundar 78 

Barath Kumar 72 

 

c) Mixed Referencing : Compute the revenue using Mixed Reference function. 

  Price Per Unit 

  Pdt A Pdt B Pdt C Pdt D 

City Qty Sold 10 19 48 95 

Chennai 250     

Coimbatore 300     

Salem 420     

Erode 510     

Madurai 620     

Trichy 125     
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Aim: 

The aim of the experiment is to compute the data using Cell Referencing Function in Excel.  

Procedure: 

Relative Reference: 

1. Open a New Workbook in Excel and create a data table with the given data.  

2. In the Cell (D1) type the column header as Net Income. 

3. Select the corresponding cells in the column (D2:D8) and then type the formula ‘=B2-C2’ and press CTRL + Enter. 

4. The Net Income will be generated for all the months using Relative Reference.  

Absolute Reference: 

1. Open a New Workbook in Excel and create a data table with the given data.  

2. In the Cell (C1) type the column header as Percentage. 

3. Go to Cell C2 and type the formula ‘=B3/$B$2’ and press ‘Enter’, and the Percentage for the Student will be 

displayed. (Use Fn + F4 in Laptop for Cell Referencing) 

4. Copy and Paste the Formula for all the remaining students and the Percentage is calculated using Absolute 

Reference.  

Mixed Reference: 

1. Open a New Workbook in Excel and create a data table with the given data.  

2. Go to Cell B4 and type the formula ‘=$A4*B$3’ and press ‘Enter’, and the Revenue will be computed for Chennai 

City. 

3. Copy and Paste the Formula for all the remaining students and the Revenue for all the Cities are calculated using 

Mixed Reference.  

Output: 

Relative Reference: 

Month Total Sales Total Expenses Formula Net Income 

January 20000 12000 =B2-C2 8000 

February 24500 18670 =B3-C3 5830 

March 35000 22564 =B4-C4 12436 

April 37560 28620 =B5-C5 8940 

May 43450 29569 =B6-C6 13881 

June 52000 30780 =B7-C7 21220 

July 56860 38020 =B8-C8 18840 
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Absolute Reference: 

Name of the Student Grade Total   

Max. Mark 100 Formula Percentage 

Aarthi 69 =B13/$B$12 69% 

Aarthisusila 80 =B14/$B$12 80% 

Aarshisha 67 =B15/$B$12 67% 

Abdur Rehman 75 =B16/$B$12 75% 

Abinaya 79 =B17/$B$12 79% 

Aishwarya 67 =B18/$B$12 67% 

Ajay 77 =B19/$B$12 77% 

Ajith Kumar 66 =B20/$B$12 66% 

Ajith Sundar 78 =B21/$B$12 78% 

Barath Kumar 72 =B22/$B$12 72% 

Mixed Reference: 

  Price Per Unit 

  Pdt A Pdt B Pdt C Pdt D 

City Qty Sold 10 19 48 95 

Chennai 250 =$B29*C$28 =$B29*D$28 =$B29*E$28 =$B29*F$28 

Coimbatore 300 =$B30*C$28 =$B30*D$28 =$B30*E$28 =$B30*F$28 

Salem 420 =$B31*C$28 =$B31*D$28 =$B31*E$28 =$B31*F$28 

Erode 510 =$B32*C$28 =$B32*D$28 =$B32*E$28 =$B32*F$28 

Madurai 620 =$B33*C$28 =$B33*D$28 =$B33*E$28 =$B33*F$28 

Trichy 125 =$B34*C$28 =$B34*D$28 =$B34*E$28 =$B34*F$28 

  Price Per Unit 

  Pdt A Pdt B Pdt C Pdt D 

City Qty Sold 10 19 48 95 

Chennai 250 2500 4750 12000 23750 

Coimbatore 300 3000 5700 14400 28500 

Salem 420 4200 7980 20160 39900 

Erode 510 5100 9690 24480 48450 

Madurai 620 6200 11780 29760 58900 

Trichy 125 1250 2375 6000 11875 

Result: 

Thus, the data is computed using Cell Referencing Function in Excel.  
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Exp. No 5 MS Excel – LOOKUP Function 

 

Question: 

Demonstrate the Lookup Function in Excel with the given data (Use the Data File Exp5-Super Market Sales) 

 

Aim: 

The aim of the experiment is to demonstrate the Lookup Function in Excel with the given data. (Invoice ID is used as 

the Lookup Value) 

 

Procedure: 

Lookup Function – Lookup Function returns a value from a range (one row or one column) or an array. 

Lookup Function for Single Value: 

Here we are going to find the Product Category for a given Invoice ID 

1. Download the Data from the Data File (Use the Data File Exp5-Super Market Sales). 

2. Go to Cell J1 and K1 and create a small table with headers Invoice ID and Product Category respectively. 

3. In Cell J2 type the Invoice ID (56001) and go to Cell K2 and type the formula ‘=LOOKUP(J2,A2:H1001)’ and 

press ‘Enter’, and the corresponding Product Category will appear.  {Formula‘=Lookup(lookup_value, array)’} 

4. Now upon changing the Invoice ID in Cell J2 the corresponding Product Category will appear in Cell K2. 

Note: Lookup Value if the First Column of the Table Array and the Lookup Vector will from the Last Column of the 

Table Array. 

 

Lookup Function for Full Record: 

Here we are going to find the Complete Record for a given Invoice ID 

1. Download the Data from the Data File  

2. Go to Cell H1 and create a small table with headers Invoice ID, Branch, City, Customer Type, Gender and Product 

Category respectively. 

3. In Cell H2 type the Invoice ID (56001) and go to Cell I2 and type the formula 

‘=LOOKUP($H$2,$A$2:$A$1001,B2:B1001)’ and press ‘Enter’, and the corresponding Branch will appear.  

{Formula‘=Lookup(lookup_value,lookup_vector,[ result_vector])’} 

4. Copy and Paste the Formula for all the cells. Now upon changing the Invoice ID the value of all the other cells will 

change respectively.  
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Output: 

Lookup Function for Single Value: 

 

Lookup Function for Full Record: 

 

 

Result: 

Thus, Lookup Function is demonstrated in Excel. 
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Exp. No 6 MS Excel – VLOOKUP Function 

 

Question: 

Create a Billing Data Table to populate data with the Product SKUs using VLOOKUP Function. (Use the Data File 

Exp6-ProductSKU) 

Aim: 

The aim of the experiment is to create a Billing Data Table and to populate data with Product SKUs using VLOOKUP. 

Procedure: 

1. Download the data from the Data File (Exp6-ProductSKU). 

2. From Cell E1 to J1 type the Row Headers for Product SKU, Product Category, Brand, Unit Price, Quantity and 

Amount respectively.   

3. Select the Cells E2:E10 and Click on the ‘Data Tab’ in the Menu bar and in the ‘Data Tools Segment’ Click on 

‘Data Validation’. 

4. In the Data Validation Pop Up , Go to the ‘Setting Tab’ and under Validation Criteria in Allow, select List in the 

Drop Down. 

5. Under the Source Click the small upward arrow near the box and select the array of values under Product SKU and 

Click on Ok. This will enable the list of Product SKUs as a drop-down list.  

 

6. In Cell F2 type the formula ‘= VLOOKUP(E2,$A$2:$D$61,2,0)’ and press ‘Enter’. 

7. In Cell G2 type the formula ‘=VLOOKUP(E2,$A$1:$C$61,3,0)’ and press ‘Enter’. 

8. In Cell H2 type the formula ‘=VLOOKUP(E2,$A$1:$D$61,4,0)’ and press ‘Enter’. 

9. Enter an assumed quantity to denote the number of units purchased.  
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10. In Cell J2 enter the formula ‘=H2*I2’ and press ‘Enter’ 

11. Now change the SKU values in the Cell E2 using the dropdown and you will see the corresponding values change 

in the other cells.  

12. In the Cell H11 type ‘Total’ and in the cell I10 and J10, use the Autosum function and compute the Total Value of 

the purchase amount.  

Result: 

Thus, Billing Data Table is created using VLOOKUP Function in Excel  

Output: 

 

 

 

Note: Rules for VLOOKUP 

1. Lookup Values should be unique in the column.  

2. VLOOKUP finds values from the left to right.  

3. LOOKUP Values should belong to the first column of the table array.  

Match Modes: 

0 - Exact match. If none found, return #N/A. This is the default. 

-1 - Exact match. If none found, return the next smaller item. 

1 - Exact match. If none found, return the next larger item. 

2 - A wildcard match where *, ?, and ~ have special meaning. 
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Exp. No 7 MS Excel – VLOOKUP Function 

 

Question: 

Using HLOOKUP create a Data Table as given below to search for the Employee Data, for the 5 Employee IDs below.  

EmpID Full Name Department Annual Salary 

E04332    

E00530    

E02059    

E02202    

E03580    

E03247    

 

Aim: 

The aim of the experiment is to create a Data Table using HLOOKUP function in Excel to search for employee details 

for the given 5 Employee IDs.  

Procedure: 

1. Download the Data from the Data File (File Name:Exp7-EmployeeData). 

2. Go to Cell A17 and create a table with Headers EmpID, Full Name, Department and Annual Salary respectively. 

3. Now to create a search function using HLOOKUP, go to cell A18 and type the given EmpID. 

4. In cell B18 type the formula ‘=HLOOKUP(A18,A2:ALM15,2,0)’ and press ‘Enter’. The Full Name of the 

Employee for the respective EmpID will be displayed.  
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5. In cell C18 type the formula ‘=HLOOKUP(A18,A2:ALM15,4,0)’ and press ‘Enter’. The Department of the 

Employee for the respective EmpID will be displayed.  

6. In cell D18 type the formula ‘=HLOOKUP(A18,A2:ALM15,10,0)’ and press ‘Enter’. The Annual Salary of the 

Employee for the respective EmpID will be displayed.  

7. Now Copy & Paste the formula for the remaining Employee ID and the Data Table will be created.  

Result: 

Thus, the Data Table with the requested details has been created for the given 5 Employee IDs using HLOOKUP 

Function.  

Output: 
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Exp. No 8 MS Excel – PIVOT Tables and Charts 

 

Question: 

Analyse the Super Market Sales Data and prepare a Table and Chart using PIVOT Function. (Use the Data File Exp8-

Super Market Sales) 

Aim: 

The aim of the experiment is to create a Pivot Table and Pivot Chart to analyse the Super Market Sales Data. 

Procedure: 

To create Pivot Table 

1. Download the Super Market Sales Data File.  

2. Click on the ‘Insert Tab’ from the Menu Bar and Select ‘Pivot Table’ from the Tables Segment.  

3. In the Pivot Table popup select the Table / Range 

4. In the ‘Choose where you want the pivot table to be placed’, select the option ‘New Worksheet’ and click ‘Ok’.  

 

5. From the Pivot Tables Field select the required fields for Filters, Columns, Rows and Values as shown in the 

screenshot. 
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6. Click on ‘Ok’ and the Pivot Table will be populated.  

To create Pivot Chart: 

1. Download the Super Market Sales Data File.  

2. Click on the ‘Insert Tab’ from the Menu Bar and Select ‘Pivot Chart’ from the Tables Segment.  

3. In the Pivot Table popup select the Table / Range. 

4. In the ‘Choose where you want the pivot table to be placed’, select the option ‘New Worksheet’ and click ‘Ok’. 

5. In the Pivot Table Fields, drag and drop the required fields for the chart in the Filters, Axis and Values field as given 

in the below screenshot.  

6. The Pivot Chart will be created.  
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Result: 

Thus, the Super Market Sales Data has been analysed using Pivot Table and Chart function in Excel.  


